Using Audacity to Podcast: University Classroom Version
Dr. Marshall Jones
Riley College of Education, Winthrop University

Audacity is available for the Mac and PC. It is free. (That’s right, FREE!) You can find it at
http://audacity.sourceforge.net/. If you don’t feel comfortable downloading it and installing it yourself

you can call user support at 2400 and ask them to install it for you.

Audacity lets you create and edit audio files or Podcasts. You can save your Audacity file and work on it
over time. However if you want to distribute your Podcast you need to export it as an .mp3 file. To
export an .mp3 file Audacity needs an external file. You will need to download this file separately and
save it to the Audacity folder of your Mac or PC. When you export as an .mp3 file for the first time, you
will need to locate the file the first time. (The software does prompt you to do this.) Once you do it, you
will never need to do it again. Never. That is a really long time, when you stop to think about it. The
table below shows you where you can find the files on line. | have them as well and would be happy to
send them to you as an email attachment.

Windows: Macintosh

lame_enc.dll lamelLib

Available: Available:
http://spaghetticode.org/lame/ http://spaghetticode.org/lame/

| have also prepared a Podcast and an accompanying PowerPoint Presentation on some definitions,
issues, and strategies for using Podcasting in university classrooms. You can find these at:

http://coe.winthrop.edu/jonesmg/Iti/podcasting/defaut.htm

There is a nice tutorial online as well that you might want to look at. It can be found at:
http://www.how-to-podcast-tutorial.com/.

You are free to use my handouts and my materials with others. If you do, please let me know that you
are using them (it is nice to know these things, plus it helps on my annual report), and please leave my
name and copyright information on the handouts as well.
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Section One: Overview of Audacity

The software looks like this when you open it:

Flle Edit View Project Gemerate Effect Analyze  Help
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The Table below will review what each part does.

File Edit Miew Project Generaske Effect  Analyze Help Contr.OIS' such as newf Sa.ve and open under
the File Menu. You will find copy, paste, and

cut under the Edit Menu. Use the Project
menu to import background music. The
Effect Menu will let you add professional
sounding fades, reverb and echoes to your

project.
| I - ‘? The Tool Set. The three we will work with
= T Jo
are the Select tool ', the Zoom tool,
Lo x

and the Time Shift tool **

The Control Pad. This is where you control
[ B 2 ] ] | the software to record, play, pause, stop,
rewind and skip forward. These should look
familiar to you.

L I T | Output Volume Meter. This meter provides

Rr—-r——r-—-—lu visual feedback on how loud your file is. Of
o) = -21 0 | course, you should be able to tell how loud it

is by listening to it too. Keeping your file
between -21 and 0 will help make the audio
levels consistent.

L | | Input Volume Meter. This meter shows you

RL,,,_,,,,_,,,,_,,,,_,,,, - | how loud you are registering when you

M 21 0 | speak. Try to keep your voice level between

-21 and 0.
) T ] + Output Volume. This controls the volume of
your recorded file.
}9 - o + Input Volume. This controls the microphone

level when you are recording. To get the
voice levels between -21 and 0 you will need
to move this control to the — or +. You can
also sit closer or further away from the mic.
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When you are recording an audio file, it will create an Audio Track and the software will look something
like this:

File Edit View Project Generate Effect Analyze Help
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The table below explains what all of this mean.

% [audio Track w [ 1.0 An Audio Track. When you are
'1"1;':; 00 | g ' recording, your voice print will look like
e | Soio | [ g0l this. The louder your voice is further it
Y - W will be from the center line. You control
L. g R 08 the input volume by sliding the Input

-1.0 Volume control (see page 2) or by sitting
closer or further from the mic. You can
edit the sound much like you edit text in
a word processor: Highlight it with the
mouse, then copy, paste, or delete as
needed.

-30 2.0 -1.0 ﬂ}[l 1.0 2.0 3.0 4.0 5.0 6.0 1.0
L L

The numbers above the Audio track

X |&udio Track ¥ | 1.0

represent time in seconds. This is the
Tg:’; ooz | g time scale. This audio file is 7 seconds
mae | sao || g0 long. Noting where you are in the terms
T o of ‘minutes and sgconds will help you
N e edit your sound file later.

As you record you will get multiple tracks. This may be music playing behind your voice, or it may be

another piece that you are speaking. It will look like this if you record at the end of the first audio track:
= Avdagity ]

Fils Edit “iew Project Generate Effect Analyze Help
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L | L h L f | |

X [&udio Track * | 1.0
Mono, 44100HZ
16-bit
Mute | Salo

s
0.0

05
L R
9 1.0
> [&udio Track * | 1.0
Monao, 44100Hz
16-hit
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s
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Section Two: Audacity Quick Start

Double click on the
Audacity icon

4

Audarity

Click on the Record button

Start Talking

(Bl
LTALE o
| TALK TO MYSELF
TaLk
o M“&F

Press Pause. This will pause
the recording and allow
you to catch your breath
and compose your
thoughts. Pressing pause
also means that you will
still be recording in a single
Audio Track.

Press Pause again and
continue talking. Repeat as
needed. Remember: you
will stay in the same audio
track as long as you are
using the pause button. As
soon as you hit the stop
button you will create a
new track.

o+

(Bl
LTALE o
| TALK T0 MYSELF
TaLk
0 byse,

Press Stop when you are
done.

Edit and Save. Export as
mp3 when you are done.

File name: |F'|:u:Ic:a$t_DNE.m|:u3

Save as type: |MP3 files [*.mp3)

[
[

Save

[ o |
Cancel
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Section Three: Editing A Single Track Audio File

1. Listen to your sound file. | =ikl . L] . -__
Use the times above the X[ &udic Track ¥
audio track to note tana, 44100Hz
where you might need to 16-bit
edit. You can delete CISIENNE

- +
“ums” and “uhs” if you =
need. You can also L o R
increase or decrease the
volume of the audio
track by liding the gain
control towards the
-or+
2. Record afile (I know, this 0 % e % 5 4 %
. X|Audi0 Track ¥ [ 1.0
seems obvious) Wono, 44100Hz
1 6-hit us
hdute: Solo 0.0
L @ R -05
@ -1.0
1.0 0.0

3. Use the Select tool ]T to | & : : L

I . x[2udio Track [ 1.0
highlight a section you Mono, 44100Hz

wish to delete. 16-hit
iute Solo

04
0.0 1

-05
L F
@ -1.0

4. Press the delete key on the keyboard and what you have selected goes away. This is much like
word processing at this point. This means, of course, that you can copy or cut the sound from
one place in the track and paste it somewhere else in the track. Use the Time Scale to help you
figure out where you need to be to edit.
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Section Three: Creating a Multi Track Audio File

When you record a track and press stop,
that track is done. The next time you
click the record button a new track will
be created. The new track is created at
whatever point on the timeline the
original audio track is at. In the example
on the right you will see that the second
track (the one on the bottom) will play
after the first track (the one on the top).
This difference is only visual. You will not
hear a difference when you play the
tracks back.

-1.0 (X 1.0 20 30 4.0 5.0
L L L s L L L

X | Audio Track ™ | 1.0
Mona, 44100Hz
16-bit
Mute Solo

@
ERSRRN

X|Second On w [ 1.0
Mono, 44100Hz
16-bit
Mute | Solo .04

9}
b.g-B| ,,

Multiple Tracks can be confusing. You
can name the tracks to make it easier to
keep up with them. Click on the “Audio
Track” button.

x| audio Track ™ 1.n'|
e |
1

A pop up window will allow you to name
the track.

Track Name

Change hack name to:

|Second One

o]

Cancel |

You can move tracks around using the
Time Shift Tool ¥*. Simply select the

tool ¥* and you can move the entire
contents of a track

| can’t really illustrate moving here, but if you go to
the How To PodCast tutorial at:
http://www.how-to-podcast-tutorial.com/ you can

see some hice animations of it.

It is possible to take the contents of one
audio track and copy it and paste it into
another audio track. Use the Select Tool

I to highlight the contents of one
audio track. Copy the selected items,
then click your mouse in another audio
track at the point you would like to
paste. Then paste. You could then delete
the file you copied from by clicking on
the small “X” in the upper left hand
corner of the Audio Track window.

| Audio Track ™ | 1.0
Mono, 44100Hz
16-bit 021
hute Salo 0.0 -
- +
@ 05
A T
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Section Four: Adding Background Music

1. You will need to have some music to put into your project. While it is technically possible to use

commercially produced music (like from CD’s you own) you can only use approximately 30

seconds of that sound file without violating copyright laws. | recommend that you look at the

music collections at FreePlay music (http://freeplaymusic.com). This instrumental music works

well as background or intro music. This site provides complete songs as long as three minutes or

as short as 10 seconds. Plus, if you are not commercially broadcasting or selling your content

you pay no royalties to use the music and those rights are granted to you in perpetuity. A pretty

good deal. So, get some music, save it to your computer.

2. Record your voice tracks,
and save them. Go to the
Project Menu and drag
down to Import Audio.

IM Generate Effect  Anakvze Help

Import Sudia. ..

I Import Labels, ..

3. Navigate to the folder your
music is in, select your
music, and click on the Open
Button.

Select one or more audio files...

Chrl+I I

Loak in: |h3 My Music

My Recent
Documents

&

My Documents

My Computer

My Metwork
Flaces

x| & ® o E

RIX]

|| Al Might 30,way
|4 | &M Five by Five 30, wav
|| a0utback Popstar 30.way
|| aPride 30.way
|| Arcade Fire-Meighborhood _3 Power Qut.mp3
|| aSunset Cruise 30.way
aThrilla
|| Bad Religion-Can't Stop It mp3
|& | Bad Religion-Supersonic, mp3
|4 | Blondestarz004, mp3
|4 | Burnside, R[1]. L.-Walkin' Blues.mp3
|4 | Cappacino 30, wav
|| Cassidy_Buxom.mp3

< |

| ity Shey)
& Connells
| Cracker;
|# Doc and
| Donelly,
|| Dol
&' Dropkick
| Galactic
1| Godwill,
&' goodridy
|8 Hardball
| Mussel,
| New Pory
>

File: narne: |aThnIIa Iway

=

[ files 1)
[ Open as read-only

Files of type:

=]

Open
Cancel

4. Your music will show up as an Audio Track below your Voice Audio Track. You will see a right

and a left channel because most music is recorded in stereo.

X [Augio Track w [ 1.0
Mona, 44100Hz

16-bit

0s

Mute Solo 0.0
- o +
05
L R
@ -1.0
X[aThrilazn_ w10
Stereo, 44100Hz us
32-hit flost
Mute Sola 0.0
- o +
-05
L &) R

-1.0

1.0

03

05

-1.0
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You will likely need to edit
your music at this point.
Your music may be too loud
and may be drowning out
your voice. You can control
that by turning the volume
up or down on a particular
track as needed using the
slider control for Gain. Often
it is necessary to turn your
voice up and the music
down. Listen to the file to
make sure your volume is
where you want it.

Remember that you can
move your audio tracks
around as needed. Select
the Time Shift Tool and you
can move your Voice Track
over to allow for an audio
introduction.

aThrila 30 ¥
Steren, 441 00Hz
32-bit flost

Sl
- +
(]

If your music is too long, you
can delete parts you don’t
want by highlighting them
and deleting them. If you
music is too short, you can
loop it by highlighting a
section, copying it, and
pasting it at the end of a
track.
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8. You may want to have your
music fade in (or crescendo

for you music people) or 32-hit flost
Mute | Solo
fade out (decrescendo) as _ "
needed. To do this, select IS E
the section you wish to fade L_@_H

in.

XIaFunkx fun ™™

Stereo, 44100Hz

9. Go the Effect Menu and
select Fade In.

I!Hm Analvze Help

Repeat Fade In

Ctrl+R.

armnplify, .
Bass Boost, ..
Change Pitch...

Change Speed...
Zhange Tempo...
Click, Reemarval, ..

Campressor, .,
Echo...
Equalization. ..

Fade Cuk

T il -

10. If you compare the graphic
in step 8 (where you select)

to the graphic in this ste S

N ° Mute | Sol | go
you will notice that now the ~ N !
selected part of the track L.

visually appears to fade in. If
you listen to it, it will fade
in. Fade Out would look,
obviously, the opposite.

XIaFunkE Dun ™

Stereo, 44100Hz

o b
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Section Five: Exporting Your File as an MP3

1. When you are ready to finish £ Audacity
your project, you will want to M Edit ‘iew Project  Gener
Export it as an MP3 file. You Mew
can do this by going to the File Open...

Menu and Dragging down to Close

Export as MP3...

Save Project
Save Project As..,

The software will likely give Recent Files...

you a warning that your file Export As WA,
will be mixed to a single track.
And that is fine, so click OK. Expart As MP3...

2. If you are saving the file for
the first time, you will need to
locate the lame_enc.dll (for
Windows) or the lamelib (for
Macintosh). See the
instructions on the first page
for what this means and
where to get them.

3. Name the file appropriately
and make sure you notice File rame |pndcasting_F'arl1.mp3 j Save

where you are saving it. When

Save as type: |MF'3 fles [* mp3) j Cancel

| podcast, | will try and keep

my audio files between 3 and
10 minutes long. This helps in
organization, and most people
don’t want to listen to a full
hour of me talking (imagine
that). This might mean that |
end up with multiple files. So
what | like to do is name them
with the title and part
number. The example on the

right shows you what | mean.
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4. The next step is to add the ID3
tags. ID3 tags are containers
that hold information about
an MP3 file. The containers
hold the artist’s name, the
album name, and the track
title. You see these when an
MP3 file plays on your
computer. Additionally, it will
become possible to search
your computer for these files
by these tags later.

Select ID3v1 (more
compatible)

Title = Title of the current
podcast

Artist = you

Album = The name of the full
lecture

Track number should
correspond to part number
The Year would be the current
year.

You will likely not find the
genre you want on the list, so
choose other, unless you are
recording “Death Metal”
music.

Edit the ID3 tags for the MP3 file %

Faormat:

o D3] [more compatible]
" 1D3v2 [more flexible]

Title: |Part 1

Artist: |MarshallJones

Albumn:  |Podcasting with Audacity

Track Mumber: |1 Year |2007

enre: ||:Ither j

Other ~
Commentz: |Pop

R&B

Fap

Regnae

— Rock,

Technio o
[rdustrial
Alternative
Ska

D eath b etal

Pranksz

Soundtrack,

Euro-Techho

Ambient

Trip-Hop bl

Voila. You are done, baby. Adam Curry has nothing on you. You will need to decide what to do
with your files. You can place them on a website or store them in WebCT for students to access.
You could burn them as a standard audio CD as well. For an example of what | do with these,
take a look at the Reusable Learning Objects | use with my EDUC 275 Class at:
http://coe.winthrop.edu/educ275/06 ROLO/
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